
 

SERVER & CONTROLLER SOLUTIONS

 

Fiery

 

®

 

 EXP4110

 

Printing from Windows



 

© 2005 Electronics for Imaging, Inc. The information in this publication is covered 
under

 

 Legal Notices

 

 for this product.

45051576
22 September 2005



CONTENTS 3

 

C

 

ONTENTS

 

I

 

NTRODUCTION

 

5

 

Terminology and conventions

 

6

 

About this document

 

7

 

Setting up printing

 

7

 

User software

 

8

 

System requirements

 

8

 

I

 

NSTALLING

 

 P

 

RINTER

 

 D

 

RIVERS

 

9

 

Installing printer drivers by Point and Print

 

10

 

Downloading printer drivers using WebTools

 

12

 

Installing printer drivers

 

14

 

Installing and connecting to a virtual printer

 

17

 

S

 

ETTING

 

 U

 

P

 

 P

 

RINTING

 

 C

 

ONNECTIONS

 

18

 

Printing connections

 

18

 

Completing the SMB printing connection

 

19

 

Completing TCP/IP and LPR printing connections

 

20

 

Completing IPX (Novell) connections

 

23

 

Completing IPP connections

 

25

 

C

 

ONFIGURING

 

 I

 

NSTALLABLE

 

 O

 

PTIONS

 

27

 

Configuring installable options manually

 

28

 

Configuring installed options and updating print options settings automatically

 

30

 

C

 

ONTENTS



CONTENTS 4

 

P

 

RINTING

 

 U

 

TILITIES

 

32

 

Configuring the connection for Job Monitor

 

33

 

Installing printing utilities

 

34

 

Using Printer Delete Utility

 

35

 

Configuring the connection for Mail Port

 

36

 

Using E-mail Service

 

39

 

How E-mail Service works

 

40

Printing using an e-mail client 40

Job Control 42

Printing using Mail Port 43

 

P

 

RINTING

 

44

 

Printing from applications

 

45

Setting options and printing 45

Accessing print options without opening print option bars 50

 

Defining and printing custom page sizes

 

51

Working with custom page sizes for Windows PCL printer driver 53

 

Saving files to print at a remote location

 

56

 

I

 

NDEX

 

57



INTRODUCTION 5

 

I

 

NTRODUCTION

 

This document describes how to install the printer drivers and printer description files for 
the Fiery EXP4110, and how to set up printing from Microsoft Windows computers. It also 
describes several printing utilities and how to print to the Fiery EXP4110. For information 
about setting up network servers and clients to use the Fiery EXP4110, see

 

 Configuration and 
Setup

 

. For general information about using the printer, your computer, application software, 
or your network, see the documentation that accompanies those products.

The Fiery EXP4110 supports the Xerox 4110.
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Terminology and conventions

 

This document uses the following terminology and conventions.

The Fiery EXP4110 includes support for WebTools, which allow you to download printer 
drivers and printer description files to your desktop for installation on your Windows 
computer. 

 

Term or convention Refers to

 

Aero Fiery EXP4110 (in illustrations and examples)

Fiery EXP4110 Fiery EXP4110

Printer Xerox 4110

Titles in 

 

italics

 

Other documents in this set

Windows Microsoft Windows 2000, Windows XP, 
Windows Server 2003

Topics for which additional information 
is available by starting Help in the software

Tips and information

Important information

Important information about issues that can result
in physical harm to you or others
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About this document

 

This document covers the following topics:

• Installing printer files on Windows computers

• Setting up printing connections on Windows computers

• Installing Fiery EXP4110 printing utilities

• Printing from Windows computers

 

Setting up printing

 

The following table lists the procedures for installing printer drivers and setting up the 
printing connections for each Windows platform supported by the Fiery EXP4110.

 

Action Windows 2000/XP/Server 2003

 

Installing printer drivers “Installing printer drivers by Point and Print” on page 10

“Downloading printer drivers using WebTools” on page 12

“Installing printer drivers” on page 14

Setting up SMB printing “Completing the SMB printing connection” on page 19

Setting up TCP/IP printing “Completing TCP/IP and LPR printing connections” on page 20

Setting up IPX/SPX 
or IPX (Novell) printing

“Completing IPX (Novell) connections” on page 23

Setting up IPP printing “Completing IPP connections” on page 25
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User software

 

Fiery EXP4110 user software for setting up printing is provided on the User Software 
(Drivers) CD.  

 

N

 

OTE

 

: 

 

You can also download PostScript printer drivers and printer description files from 
the Fiery EXP4110 using WebTools. For instructions, see “Downloading printer drivers 
using WebTools” on page 12.

 

N

 

OTE

 

: 

 

Two User Software CDs are provided, one for the printer driver and the other 
for utilities.

 

System requirements

 

For detailed system requirements, see

 

 Welcome

 

, provided in your media pack.

 

Adobe PostScript 
Printer Driver

Supports Fiery EXP4110 and PostScript 3 features.

Windows 2000/XP/Server 2003 users use the PostScript 
Printer Driver provided with those operating systems.

PostScript Printer 
Description (PPD) file 

Provides information about the Fiery EXP4110 and your 
particular printer model to your application and printer driver.

PCL Printer Driver Allows you to print to the Fiery EXP4110 from Windows 
computers, and supports Fiery EXP4110 PCL print features. 

Job Monitor Allows you to monitor the status of connected Fiery EXP4110 
servers and print jobs sent to them. 

Automatically installed when the printer driver is installed 
on a Windows computer.

 Mail Port (on User Software 
(Utilities) CD) 

Allows you to send jobs to the Fiery EXP4110 in the form of 
e-mail attachments by adding the Mail Port software as a 
printer port.
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I

 

NSTALLING

 

 P

 

RINTER

 

 D

 

RIVERS

 

This chapter describes the procedures for installing printer drivers on a computer using a 
supported version of Windows. For the Windows versions supported, see “Terminology and 
conventions” on page 6. Installing printer drivers and printer description files is the first step 
in setting up the Fiery EXP4110 as a PostScript or PCL printer.

Install printer drivers as follows:

• From the Fiery EXP4110 through Point and Print using SMB printing.

• From WebTools, by downloading the printer driver files before installing the printer 
driver. For instructions, see “Downloading printer drivers using WebTools” on page 12. 

• From the User Software (Drivers) CD.

 

N

 

OTE

 

: 

 

WebTools is available if the administrator has enabled Internet access to the 
Fiery EXP4110.

If a Fiery EXP4110 printer driver is already installed, you must uninstall it before you install 
a new one (see “Using Printer Delete Utility” on page 35).
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Installing printer drivers by Point and Print

 

SMB printing (also known as Windows or WINS printing) allows you to install PostScript or 
PCL printer drivers and printer description files on your computer from the Fiery EXP4110 
using Point and Print, and print to a particular connection (Print queue, Hold queue, or 
Direct connection). To set up SMB printing, you must install the TCP/IP protocol and 
Client for Microsoft Networks on your computer.

Each connection (Print queue, Hold queue, or Direct connection) requires a separate 
installation. Repeat the procedure for each connection.

When you install the printer driver using Point and Print, you cannot configure installable 
options manually. Installable options must be configured by the Fiery EXP4110 
administrator. The installed options are displayed in the printer driver when you enable 
Two-Way Communication. For more information, see Configuring Installable Options.

 

N

 

OTE

 

: 

 

The procedures for setting up printing with the PostScript and PCL printer drivers are 
similar. The following illustrations show the PostScript drivers. Any differences are noted.

 

B

 

EFORE

 

 

 

YOU

 

 

 

BEGIN

 

• Ask your network administrator for the IP address or name of the Fiery EXP4110 on 
the network.

• Configure the Fiery EXP4110 for SMB printing.

 

SMB printing is referred to as Windows Printing in Setup and on the Configuration page 
(see 

 

Configuration and Setup

 

).

 

• Indicate whether to install the PS or PCL printer driver using Point and Print in Network 
Setup>Service Setup>Windows Setup>Point and Print Drivers.

 

T

 

O

 

 

 

SET

 

 

 

UP

 

 SMB 

 

PRINTING

 

 

 

ON

 

 W

 

INDOWS

 

 COMPUTERS

1 Right-click Network Neighborhood or My Network Places, and select Find Computer or Search 
for Computers.

2 Type the name or IP address of the Fiery EXP4110 and click Search Now.

If you cannot locate the Fiery EXP4110, contact your network administrator.
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3 Double-click the name of the Fiery EXP4110 to display enabled print connections.

NOTE: For a description of each print connection, see Configuration and Setup.

4 Double-click the connection that you want to set up (Hold, Print, or Direct).

The files are installed on your computer.

5 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

The printer is displayed in the Printers or Printers and Faxes window.

6 Right-click the Fiery EXP4110 icon and choose Properties.

7 Click Print Test Page on the General tab.

If the test page prints successfully, you are ready to print from the computer.

8 Repeat the previous steps for the other connections that you want to set up.
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Downloading printer drivers using WebTools
WebTools allows you to download installers for printer drivers to your computer directly from 
the Fiery EXP4110.

Download the printer driver files from the Fiery EXP4110 using WebTools and then follow 
the procedures in “Installing printer drivers” on page 14. Before downloading the printer 
driver files, you must set specific Fiery EXP4110 options in Network Setup and Printer Setup. 
You also must prepare each client computer to communicate with the Fiery EXP4110 over 
the Internet or intranet.

For more information about Network Setup and Printer Setup, see Configuration and Setup.

For more information about setting up and starting WebTools, see Utilities.

TO DOWNLOAD PRINTER DRIVER FILES WITH WEBTOOLS

1 Start your Internet or intranet browser and type the DNS name or IP address of 
the Fiery EXP4110.

2 Select a logon level, type a password, if required, and then click OK.

No password is required to log on as a guest. If the administrator has configured guest access, 
any user has full access to the Downloads tab while logged in as a guest.

3 Click the Downloads tab.

4 Click the link for the item that you want to install. 

For Windows printer drivers, click the Printer Files link under the Windows heading.



INSTALLING PRINTER DRIVERS 13

5 If a dialog box prompts you to either open the file or save it to disk, choose to save it 
to disk.

6 Browse to the location where you want to save the PRNTDRVE.EXE file and click Save.

The file is downloaded from the Fiery EXP4110. This compressed file is an archive that 
contains multiple files.

7 Double-click the PRNTDRVE.EXE file to extract the files.

Depending on your operating system, you might be prompted to select a location to extract 
the files to.

Follow the instructions for your operating system to install the printer driver. The procedures 
are the same as for installing from the CD, except that after you click Have Disk, you browse 
to the location where you extracted the files, rather than to the CD.

For instructions on installing
the printer driver for

See

Windows 2000/XP/Server 2003 “To install the PostScript or PCL printer driver for 
Windows 2000/XP/Server 2003” on page 14
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Installing printer drivers
The following procedures describe installing the printer driver from the User Software 
(Drivers) CD. 

The procedures for configuring the options for the PostScript and PCL printer drivers are 
similar. The following illustrations show the PostScript driver. Differences are noted.

To install the printer driver on a Windows Server 2003 computer, select the same PPD file as 
for Windows 2000 and Windows XP, described in the following procedure.

To use the printer driver on Windows 2000/XP/Server 2003, you must select the following 
options in the Advanced tab of the printer driver after installation is complete:

• Spool print documents 

• Start printing immediately

• Print spooled documents first

Clear the following option:

• Enable advanced printing features

NOTE: The following procedures use Windows 2000 illustrations. 

TO INSTALL THE POSTSCRIPT OR PCL PRINTER DRIVER FOR WINDOWS 2000/XP/SERVER 2003

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Choose Add a printer and click Next.

3 Specify printing using a Local printer, clear the “Automatically detect and install my Plug and 
Play printer” box, and click Next.

This procedure describes the installation of a local printer. You can modify the connection 
later, according to your network type.
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4 Select LPT1: and click Next.

5 Click Have Disk in the dialog box displaying lists of manufacturers and printers.

The Install From Disk dialog box prompts you for the disk.

6 Insert the User Software (Drivers) CD into the CD-ROM drive, type the name 
of the CD-ROM drive (for example, D:\), and click Browse. Browse to the 
English\Prntdrvr\Ps_drvr\Win_2K_XP folder.

If you are installing from the files you downloaded from the Fiery EXP4110 using WebTools, 
browse to prntdrvr\Prntdrvr\Ps_drvr\Win_2K_XP and click Open.

7 Make sure that Oemsetup.inf or Oemsetup is selected and click Open. 

The path is copied to the Install From Disk dialog box.

8 Verify that the path is correct and click OK.
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9 In the Printers box, select the Fiery EXP4110 printer driver as your printer and click Next.

10 Type a name for the Fiery EXP4110 in the Printer name field, indicate whether you want to 
make it the default printer, and click Next.

This name is used in the Printers window and the queues window.

11 Follow the on-screen instructions.

Choose not to print a Test Page and not to share this printer. At the last screen, click Finish.

The necessary files are installed on your hard disk. When installation is complete, the Printers 
window appears with an icon for the newly installed printer. 

Now you are ready to set up a connection to the server. See Setting Up Printing Connections.
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Installing and connecting to a virtual printer
A virtual printer allows you to print to the Fiery EXP4110 using a predefined set of job 
settings. You do not have to set print options manually. Before you can print to a virtual 
printer, the administrator must create and configure the virtual printer using Command 
WorkStation.Once the virtual printer is set up, you can install the printer driver and printer 
description files on your computer from the Fiery EXP4110 using Point and Print.

For more information about setting up virtual printers, see Utilities.

When you install the printer driver using Point and Print, you cannot configure installable 
options manually. Installable options must be configured by the Fiery EXP4110 
administrator. The installed options are displayed in the printer driver when you enable 
Two-Way Communication. For more information about configuring installable options, 
see Configuring Installable Options.

TO SET UP A VIRTUAL PRINTER ON WINDOWS COMPUTERS

1 Right-click Network Neighborhood or My Network Places, and select Find Computer or Search 
for Computers.

2 Type the name of the Fiery EXP4110 or the IP address and click Search Now.

If you cannot locate the Fiery EXP4110, contact your network administrator.

3 Double-click the name of the Fiery EXP4110 to display enabled print connections.

Virtual printers are listed along with the Hold queue, Print queue, and Direct connection 
(if those connections are enabled). Virtual printers usually have names that indicate the type 
of job they are set up for.

4 Right-click the virtual printer that you want and choose Connect.

The files are installed on your computer.

5 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

The virtual printer is displayed in the Printers or Printers and Faxes window.

Print to a virtual printer just as you would print to the Fiery EXP4110, as described in 
Printing. Depending on how the virtual printer is configured, you may not be able to set 
some print options.
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SETTING UP PRINTING CONNECTIONS

To print from Windows computers, you or the administrator must perform the 
following tasks:

• Set up network servers, if any.

• Set up the Fiery EXP4110 to accept print jobs from your computer.

• Configure a port on each Windows computer for the network type.

Printing connections
The Fiery EXP4110 supports the following printing connections:

• SMB

• TCP/IP and LPR

• IPX/SPX or IPX (Novell)

• IPP



SETTING UP PRINTING CONNECTIONS 19

Completing the SMB printing connection
If your network does not have a Windows server, Windows computers can still print to the 
Fiery EXP4110. This method of printing is SMB printing (also known as Windows or WINS 
printing). When users send print jobs, computers running Windows operate in a peer-to-peer 
environment and communicate directly with the Fiery EXP4110. 

Enabling SMB printing allows the Fiery EXP4110 to be listed on the network, so that 
Windows clients can print to a particular print connection (Hold queue, Print queue, 
or Direct connection) on the Fiery EXP4110 without using other networking software. 
Windows printing runs via TCP/IP. You must configure TCP/IP on the Fiery EXP4110 and 
on all computers that use SMB printing.

Once you enable SMB printing on the Fiery EXP4110, you can set up the Windows or 
SMB connection and install the printer driver in one procedure. For more information, see 
“Installing printer drivers by Point and Print” on page 10.
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Completing TCP/IP and LPR printing connections
Procedures for setting up the printing connections are described in the following sections.

NOTE: TCP/IP printing is different from a TCP/IP connection. Setting up TCP/IP printing 
and configuring your computer for TCP/IP connection are two separate steps.

Once you have installed the PostScript and printer driver files, complete the setup for the 
TCP/IP and LPR connection as follows:

• Prepare the Fiery EXP4110 to accept print jobs using TCP/IP and LPR protocols. 
For details, see Configuration and Setup.

• Enable LPD or Port 9100 on the Fiery EXP4110. For details, see Configuration and Setup.

• Configure the computer for the TCP/IP connection.

Before you complete the following procedure, contact your system administrator for the 
IP address assigned to the Fiery EXP4110, the subnet mask, and the gateway address, 
if required.

The TCP/IP protocol should already be installed on the Windows 2000/XP/Server 2003 
computer.

NOTE: You can also set up the LPR connection by installing Print Services for UNIX, which is 
supplied as an add-on Windows component with Windows 2000/XP/Server 2003. For more 
information, see the documentation that accompanies Windows.

TO SET UP TCP/IP AND PORT 9100 OR LPR CONNECTION FOR WINDOWS 2000/XP/SERVER 2003

NOTE: The following procedures use Windows 2000 illustrations.

1 Click Start, choose Settings, and then choose Printers.

2 Right-click the Fiery EXP4110 icon and choose Properties.
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3 Click the Ports tab.

4 Click Add Port. 

5 Select Standard TCP/IP Port from the list of Available port types and click New Port Type. 

The Add Standard TCP/IP Printer Port Wizard dialog box appears.

6 Click Next. 

7 Type the Fiery EXP4110 IP address. 

8 Click Next.

9 Make sure that Generic Network Card is selected as Standard for Device Type and click Next.
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10 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click 
Close in the Printer Ports dialog box.

11 Click Configure Port in the Ports tab of the Properties dialog box.

The Configure Standard TCP/IP Port Monitor dialog box appears.

12 If LPD printing is enabled on the Fiery EXP4110, select LPR in the Protocol area and LPR Byte 
Counting Enabled in the LPR Settings area.

NOTE: You can also proceed without selecting LPR Byte Counting Enabled.

If Port 9100 printing is enabled on the Fiery EXP4110, select Raw in the Protocol area. 

The port number 9100 automatically appears in the Raw Settings area. This is the default 
port number. You can print to the printer connection selected for Port 9100 printing on 
the Fiery EXP4110.

To specify a specific port number, see the following step.

13 Type the name of the print connection.

For LPR, type print or hold for Queue Name. The Direct connection is not supported for 
LPR printing.

For Port 9100, type the following port numbers for each print connection in the Raw Settings 
area:

Fiery EXP4110 default: 9100

direct: 9101

print: 9102

hold: 9103

NOTE: Type the number exactly as shown.

14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.
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Completing IPX (Novell) connections
Complete the setup for the IPX (Novell) connection as follows:

• Configure the Novell network and file server for handling Fiery EXP4110 print jobs. 
Configure the file server with a print server and print connection for the Fiery EXP4110. 
For more information, see the documentation that accompanies NetWare.

• Prepare the Fiery EXP4110 for IPX printing.

• Set up the IPX connection on the computer.

Before you begin, install NetWare protocols (NWLink IPX/SPX Compatible Transport) and 
NetWare client services on the Windows 2000/XP/Server 2003 computer.

TO SET UP IPX (NOVELL) PRINTING FOR WINDOWS 2000/XP/SERVER 2003

1 Windows 2000: Double-click My Network Places.
Windows XP: Click Start and then click My Network Places.
Windows Server 2003: Click Start, choose Explorer, and then click My Network Places.

2 Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

3 Double-click the NetWare tree or file server for which the network administrator defined a 
print connection for the Fiery EXP4110.

You may have to log on to the file server to see the print connections.

4 Double-click the print connection defined for the Fiery EXP4110.

5 If the NetWare server does not have a suitable driver for the Fiery EXP4110, you are asked if 
you want to set up the printer on your computer. Click Yes.

6 Click OK to install the Fiery EXP4110 PostScript printer driver.

7 Follow step 6 through step 11 of the procedure “To install the PostScript or PCL printer driver 
for Windows 2000/XP/Server 2003” on page 14.

When installation is complete, a new printer window appears, with the name of the print 
queue on the NetWare server.
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8 Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for 
the Fiery EXP4110.

9 Click the General tab and click Print Test Page.

10 In the printer Job Notes field, type user and job identification information, and then 
click OK.

The Test Page remains listed in the queue window until it is printed.

The Fiery EXP4110 polls the NetWare server for print jobs in the print connection defined 
for the Fiery EXP4110. When you print, your PostScript files are spooled to that connection 
and transmitted over the queue “port” to the Fiery EXP4110.
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Completing IPP connections
With Internet Printing Protocol (IPP), print jobs are sent to the Fiery EXP4110 over 
the Internet.

NOTE:  The IPP setup procedures are performed after installing the appropriate printer drivers 
(see Installing Printer Drivers).

Before you begin, perform the following tasks:

• Make sure the Fiery EXP4110 is configured for TCP/IP printing and IPP printing. 

For more information, see Configuration and Setup.

• Specify the printing destination on your computer.

TO SET UP IPP PRINTING WITH WINDOWS 2000/XP/SERVER 2003

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Windows 2000/XP: Double-click the Add Printer icon and click Next.
Windows Server 2003: Choose Add a printer and click Next.

3 Select Network printer and click Next.

4 Select Connect to a printer on the Internet or on your intranet. Type an IP address or 
computer name in the URL field.

The path for the printer is the IP address or DNS name followed by ipp/print (for the Print 
queue) or ipp/hold (for the Hold queue). Insert slashes between the elements, for example, 
http://10.10.10.150/ipp/print.

NOTE: The URL for the printer is not case-sensitive. 
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5 Click Next.

The Add Printer Wizard dialog box appears. 

6 Click OK.

Indicate whether you want to make the Fiery EXP4110 the default printer and click Next.

7 Click Finish.
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CONFIGURING INSTALLABLE OPTIONS

After you complete the printer driver installation, you must configure the Fiery EXP4110 
for the options installed on the printer to allow the Fiery EXP4110 to take advantage of the 
printer options. Configure the options manually, or for TCP/IP network connections, use 
the Two-Way Communication feature to configure the options automatically.
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Configuring installable options manually 
The following procedures describe how to manually configure the Fiery EXP4110 for the 
options installed on the printer. The procedures for all Windows platforms are similar. Any 
differences are noted in the text. The installable options are listed in the following table.

NOTE: For more information about the print settings that use these options, see Print Options. 

When you configure installable options manually, be sure to match the actual configuration of 
the Fiery EXP4110 and printer. Otherwise, the print options shown in the printer driver 
might not match the print options actually available.

Installable option Selections

Finisher Option None, D-Finisher

Interposer Not Installed, Interposer

Booklet Tray Option Off, On

Folder Tray Option Not Installed, Folder Tray

Optional Trays Not Installed, Trays 6 and 7 (HCF)

Punch Option Not Installed, 2/3 hole Punch, 2/4 hole Punch
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TO CONFIGURE OPTIONS MANUALLY FROM THE POSTSCRIPT PRINTER DRIVER

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 In the Printers window, select the Fiery EXP4110 PostScript or PCL printer driver icon. 

3 PostScript driver: Choose Properties from the File menu.
PCL driver: Choose Printing Preferences from the File menu.

4 Click the Accessories tab.

5 Select an installed option from the Available Options list.

6 Click Add to move the option to the Installed Options list.

7 Click OK.
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Configuring installed options and updating print options 
settings automatically

If you enabled a TCP/IP network, you can automatically update your printer driver to reflect 
the options currently installed on the printer. When the printer driver is first installed, the 
options reflect the default settings that were set up in Fiery EXP4110 Setup. When you 
update the printer driver using the Two-Way Communication feature, you allow the printer 
driver to retrieve the settings from the Fiery EXP4110.

TO ENABLE TWO-WAY COMMUNICATION

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 In the Printers window, select the Fiery EXP4110 PostScript or PCL printer driver icon. 

3 PostScript driver: Choose Properties from the File menu.
PCL driver: Choose Printing Preferences from the File menu.

4 Click the Accessories tab.

5 Select Two-Way Communication.

6 Type the Fiery EXP4110 IP address or DNS name.
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7 Select Update Fiery Driver When Opened to display the printer’s current default settings 
when the printer driver is opened.

8 Click Update.

NOTE: To confirm that Two-Way Communication is enabled, click the About tab and check 
that the Fiery EXP4110 name and other server information are displayed.

9 Select Enable E-mail Notification to receive e-mail notification after your job has been 
printed, and type the e-mail address to which an e-mail notification is sent.

You will receive e-mail notification of any errors that occur during printing.

NOTE: Enable E-mail Notification is displayed only if E-mail Service is enabled at Setup. 
For more information, see Configuration and Setup.

10 Click the Advanced tab and clear Enable Advanced Printing Features.

11 Click OK.
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PRINTING UTILITIES

You can install the following printing utilities from the User Software (Utilities) CD:

• Job Monitor

• Printer Delete Utility

• Mail Port 

NOTE: Job Monitor is automatically installed when you install the printer driver on your 
computer. To use Job Monitor, you must enable it in the printer driver. (For more 
information, see “Configuring the connection for Job Monitor” on page 33.)
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Configuring the connection for Job Monitor
Use Job Monitor to monitor the status of Fiery EXP4110 servers and view information about 
the print jobs sent to them. 

For information about using Job Monitor, see Job Monitor Help. 

TO CONFIGURE THE CONNECTION TO FIERY EXP4110 SERVERS

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 In the Printers window, select the Fiery EXP4110 PostScript printer driver icon.

3 Choose Properties from the File menu.

4 Click the Advanced tab, and clear the Enable advanced printing features option.

5 Click the Consumables tab.

6 Click Launch Job Monitor.

Job Monitor opens a utility window and establishes a connection to the Fiery EXP4110. 
If you have installed and configured printer drivers for more than one printer, Job Monitor 
automatically establishes connections to all the Fiery EXP4110 servers.

7 Click Update in the Consumables tab.

8 Click OK to close the Properties window.

The Job Monitor icon ( ) appears on the desktop and in the Windows taskbar of 
your computer.

1 Server 

1
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Installing printing utilities
You must install the printing utilities on each client computer. The installation of each utility 
is similar. Before you begin each installation, determine where you want to install each item 
on your computer. Otherwise, the software is placed by default in the Fiery folder inside the 
Programs folder.

TO INSTALL PRINTING UTILITIES

1 Open the appropriate folder for the software that you want to install.

2 Double-click the Setup.exe icon.

3 Follow the on-screen instructions to complete installation.
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Using Printer Delete Utility
Printer Delete Utility is installed and used locally, so you do not need to connect to the 
Fiery EXP4110 before you use the software.

TO USE PRINTER DELETE UTILITY

1 Click Start, choose Programs, and then choose Fiery. 

2 Click FieryPrinterDeleteUtility.

The Fiery Driver Uninstall Tool dialog box appears. Any Fiery EXP4110 printer drivers found 
on your computer are listed.

3 To delete a printer, select the printer name and click Delete.

4 Click OK to delete the selected printer driver.

5 Click OK to restart, or, to delete another printer driver, click Cancel to return to the Fiery 
Driver Uninstall Tool dialog box. When you finish deleting printer drivers, restart your 
computer.
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Configuring the connection for Mail Port
The Mail Port allows you to print to and control the Fiery EXP4110 remotely. Jobs are sent to 
the Fiery EXP4110 in the form of e-mail attachments. Set up e-mail printing on Windows 
computers by adding the Mail Port software as a printer port.

You must set up E-mail Service on the Fiery EXP4110 to use Mail Port. To set up E-mail 
Service, see Configuration and Setup. After you set up E-mail Service, install the Mail Port 
from the User Software (Utilities) CD onto your Windows computer, and then add a port.

NOTE: The following procedures are similar for all Windows platforms.

TO CONFIGURE THE CONNECTION FOR THE MAIL PORT

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Windows 2000: In the Printers window, double-click the Add Printer icon and click Next.
Windows XP: In the Printers and Faxes window, click Add a printer and then click Next.
Windows Server 2003: Click Start, choose Add a Printer, and then click Next.

3 Specify printing using a Local printer and click Next.

4 Select Create a New Port, choose EFI Fiery Mail from the Type menu, and click Next.
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5 In the Add Port dialog box, type the basic information required to set up the e-mail port. 

• Fiery’s E-mail Address: Type the e-mail address of the Fiery EXP4110.

• Outgoing Mail Server: Type the name or IP address of the SMTP server for the port to use.

6 Click Advanced.

The E-Mail Port Configuration dialog box appears.

7 Type the following information.

For Fiery Server:

• E-mail Address: The e-mail address you typed for the Fiery EXP4110.

• Queue: The print connection on the Fiery EXP4110 that you want.

For Outgoing Mail Server (SMTP):

• Server Name: The SMTP server to use.

• From Address: The “from” address to insert in the e-mail.



PRINTING UTILITIES 38

For Options:

• Break apart messages larger than: If you select this option, enter the maximum size of a 
single e-mail message. If a job exceeds this size, it is split into multiple messages, each not 
to exceed this size, and then is sent to the Fiery EXP4110. The Fiery EXP4110 
automatically combines all split messages into the original single print job for printing.

• Status messages from Fiery: If you select this option, the Fiery EXP4110 sends status 
reports of jobs printed via e-mail.

8 Click OK.

The Add Printer Wizard dialog box appears.

9 Click Next and follow the on-screen instructions for installing the printer driver for your 
Windows computer.
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Using E-mail Service
E-mail Service allows you to control the Fiery EXP4110 using your current e-mail 
infrastructure and print to remote locations and bypass firewalls. E-mail Service is not 
application-specific. You can use any e-mail infrastructure.

With E-mail Service, you can submit jobs to the Fiery EXP4110 as e-mail attachments. 

Use E-mail Service in the following ways: 

• Print and manage print jobs using an e-mail client.

• Print using the Mail Port.
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How E-mail Service works
To set up E-mail Service, see Configuration and Setup.

To print with an e-mail client, you send a file as an e-mail attachment. E-mail Service extracts 
the file and sends it to the Fiery EXP4110. The attachment can be in any format the 
Fiery EXP4110 recognizes (PostScript, PDF, or TIFF).

NOTE: E-mail Service does not process files with .vbs, .exe, or .bat extensions.

To print through Mail Port, you must set up Mail Port as described in “Configuring the 
connection for Mail Port” on page 36. When you print from an application and select the 
printer connected to the Mail Port., the print job is sent to the Fiery EXP4110 via e-mail.

The Fiery EXP4110 supports internal address books. Administrators can retrieve, add, delete, 
and clear addresses from the address books by sending requests via e-mail. For more 
information about address books, see Configuration and Setup.

Printing using an e-mail client

You can submit print jobs to the Fiery EXP4110 in the form of an e-mail attachment using 
your e-mail application. When you send an e-mail with an attachment, E-mail Service 
extracts the file and sends it to the Fiery EXP4110 Print queue. The file format must be one 
supported by the Fiery EXP4110. 

By default, anyone can print with an e-mail client, unless the Print address book has been set 
up by the administrator. If the Print address book has been set up and your e-mail address is 
not in it, you cannot send files to the Fiery EXP4110 via e-mail. For more information about 
address books, see Configuration and Setup. 

NOTE: The Hold queue and Direct connection are not supported by the e-mail client feature.

NOTE: The following illustrations depict the Microsoft Outlook e-mail application. 

TO PRINT USING AN E-MAIL CLIENT

1 Open your e-mail application.

2 Type the Fiery EXP4110 e-mail address in the To: line.

3 Type text in the Subject line or leave the Subject line blank.
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4 Attach the file that you want to print. 

The attachment can be in any format the Fiery EXP4110 recognizes (PostScript, PDF, 
or TIFF).

NOTE: If your attachment exceeds the file size limitation set by your e-mail system 
administrator, the e-mail is not sent. 

5 Optionally, you can type text in the body of the message. That text is printed with the file.

NOTE: HTML-formatted e-mail messages are not supported, and they might not print as they 
appear on the remote workstation. Send e-mail messages in plain text format.

6 Send the e-mail.

The file is sent to the Fiery EXP4110 and the job is printed. After the Fiery EXP4110 receives 
the job, you are sent an e-mail notification that the print job was accepted. The e-mail 
provides a job identification (ID). Use the job IDs to manage jobs with Job Control (see 
the following section). The e-mail notification indicates any current error at the printer. 

Once the job has been printed, you are sent a second e-mail notification that indicates the job 
printed successfully. 

NOTE: If you send a TIFF file that was compressed using G3MH or G4MMR, the file is 
printed correctly but no e-mail notifications are sent.

Use Job Control to see if your job printed successfully. 



PRINTING UTILITIES 42

Job Control

You can manage your print jobs by submitting commands to the Fiery EXP4110 via e-mail. 
You can cancel a job, check job status, and get help on a job. Once you send a command, the 
Fiery EXP4110 returns an e-mail response. 

TO MANAGE PRINT JOBS WITH JOB CONTROL

1 In your e-mail application, type the Fiery EXP4110 e-mail address in the To: line.

2 Type one of the following Job Control commands in the Subject line:

To check the status of a job, type #JobStatus<job id> in the Subject line.

You receive a reply to your job status query. You can only get the status of the job if you sent 
the job or are an administrator.

To cancel a job, type #CancelJob<job id> in the Subject line. 

You receive a notification indicating that the job has been cancelled and did not print to the 
Fiery EXP4110. You can only cancel a job if you sent the job or are an administrator.

To get help, type #Help in the Subject line.

You receive an e-mail response that contains links that allow you to cancel jobs, check job 
status, and search and manage address books. Click any of the links to perform a Job Control 
command.
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Printing using Mail Port

Once you set up Mail Port, print via e-mail in the same manner as any other printing method. 
No additional steps are necessary.

NOTE: The Direct connection is not supported when you print with Mail Port.

TO PRINT USING MAIL PORT

1 Choose Print in your application.

2 Make sure that the Fiery EXP4110 is selected as your printer and that you have installed the 
Mail Port for the Fiery EXP4110.

3 Click Properties.

4 Click the Fiery Printing tab.

5 Set the print options and click OK.

To set options using the printer driver, see “Setting options and printing” on page 45.

6 Click OK again to send your job to the Fiery EXP4110.

If the attachment exceeds the file size limitation set in your application, the attachment is 
broken into several messages.
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PRINTING

This chapter describes printing to the Fiery EXP4110. You can print from a networked 
Windows computer or a computer using Windows (WINS) printing. You can also print to a 
file so that it can be printed at a remote location (see “Saving files to print at a remote 
location” on page 56). In addition to these methods, you can download certain types of files 
to the Fiery EXP4110 using Downloader (see Utilities), and print documents using Hot 
Folders (an option) (see Utilities) and E-mail Services (see “Using E-mail Service” on 
page 39).

For information about setting up the Windows environment for printing with Windows 
servers connected to the Fiery EXP4110, see Configuration and Setup. For information about 
connecting to the Fiery EXP4110 over the network, see Setting Up Printing Connections. 
For information, see Installing Printer Drivers.
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Printing from applications
After you install the Fiery EXP4110 printer driver and configure the proper port, you can 
print directly from most Windows applications. Set the print options for the job and choose 
Print from your application.

Setting options and printing 

To print from all Windows platforms, install the corresponding PostScript printer driver or 
PCL printer driver. For instructions, see Installing Printer Drivers. The drivers are included 
on the User Software (Drivers) CD and on the Fiery EXP4110.

On Windows 2000/XP/Server 2003, be sure to configure the options in the Advanced tab of 
the printer driver after installation is complete, as described on page 14.

Once you install the printer driver and printer description files, you can specify print settings 
for a particular job and print it to the Fiery EXP4110. You can also set default print settings 
using the driver.

If you print to a virtual printer, you may not be able to set some print options, depending on 
how the virtual printer is configured.

To print from Windows applications on a computer connected to a print server, the print 
server must be a Novell NetWare, Windows 2000/Server 2003, or UNIX server. For more 
information, see Configuration and Setup. 

The following procedures explain how to use the printer driver to specify print options. 
For information about specific print options, see Print Options.

NOTE: The following procedures use Windows 2000 illustrations. The interface may vary 
slightly depending on whether you are using the PostScript or PCL driver. Major differences 
are noted. 
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TO SET PRINT OPTIONS FOR A SPECIFIC WINDOWS PRINT JOB USING THE PCL OR POSTSCRIPT 
PRINTER DRIVER

1 Choose Print in your application.

2 Select the Fiery EXP4110 as your printer and click Properties.

3 Click the Fiery Printing tab.

The Fiery Printing tab serves as the control center for all frequently used printing functions. 

NOTE: Supported tabs and print options may vary between Windows PostScript and PCL 
printer drivers. For a complete list of print options, see Print Options.

4 Click the Owner Information print option bar.

5 Type an account name in the Group Name field. 

The Group Name appears in the Job Log. The account name is defined by your administrator 
for managing purposes. For the account name, consult the administrator.

1 Job Templates, see Help
2 Print option bars
3 Shortcuts, see Help
4 Click to display all 

print options
5 Click to hide all 

print options

1

2

3

4
5
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6 Type a password in the Group Password field. 

The Group Password appears in the Job Log, but it is encrypted. The password is defined by 
your administrator for managing purposes. For the password, consult the administrator. 

When the account name and password you typed match those defined by the administrator, 
your job is printed. Otherwise, an error is generated, and your job is placed in the Printed 
queue.

The administrator or operator can edit the Group Name and Group Password from the 
Command WorkStation Job Properties dialog box. The Group Name appears in the job’s 
Notes 2 field in the Job Log.

NOTE: Group Name and Group Password options are not available when you print to the 
Direct connection.

7 Type information in the Notes field.

The information you enter in the this field can be viewed and edited by the operator in 
Command WorkStation and also appears in the Job Log.

For more information about Command WorkStation, see Utilities.

8 In the Instructions field, type instructions to the operator about the job.

These instructions are displayed in Command WorkStation, but do not appear in the 
Job Log. These instructions can be edited by the operator.

9 Click the remaining print option bars to specify the appropriate settings for the print job 
and click OK.

To quickly locate a print option, move the cursor slowly over the print option bars. A message 
appears for each print option bar that displays the print options available.

These print options are specific to the Fiery EXP4110 and the printer. They override 
settings specified in Fiery EXP4110 Printer Setup, but can be overridden from Command 
WorkStation. For information about these options and overrides, see Print Options. For more 
information about Command WorkStation, see Utilities.
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Some print options are available only if a particular installable option has been configured. 
For information about configuring installable options, see Configuring Installable Options.

If you choose Printer’s default, the job prints according to the settings specified in Setup. For 
more information, see Print Options.

NOTE: If you specify incompatible print settings, the Conflict dialog box provides instructions 
to resolve the conflict.

10 From your application, click OK to send your print job.

Make sure that the Fiery EXP4110 is selected as your current printer.

NOTE: Some print options that are selectable from an application or Adobe PS printing 
features are similar to print options that are specific to the Fiery EXP4110 and the printer. In 
these cases, use the print options specific to the Fiery EXP4110 and the printer. These options 
appear in the Fiery Printing tab. The application or Adobe PS printer driver may not set up 
the file properly for printing on the Fiery EXP4110, resulting in unexpected printing errors 
and longer processing time.

NOTE: With the E-mail Notification feature enabled in the printer driver as described in “To 
enable Two-Way Communication” on page 30, you receive an e-mail notification after your 
job is printed or when a printing error occurs.
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TO SET DEFAULT PRINT OPTIONS FOR WINDOWS PRINT JOBS USING THE ADOBE 
OR MICROSOFT POSTSCRIPT PRINTER DRIVER

1 Windows 2000: Click Start, choose Settings, and then choose Printers.
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Right-click the Fiery EXP4110 icon and choose Printing Preferences.

3 If the Fiery Printing tab is not displayed, click it.

4 Specify the default settings for your print job, as described on page 46.

5 Click OK to close the dialog box.
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Accessing print options without opening print option bars

You can also access and change the print option settings by right-clicking the print option 
bars. When you right-click a print option bar, a list of print options appears, and you can 
change settings in the list for your print job.

TO ACCESS PRINT OPTIONS WITHOUT OPENING PRINT OPTION BARS

1 Open the Fiery Printing tab.

2 Right-click a print option bar.

A list of the print options appears.

3 Click or move and hold the cursor over an option to which you want to make a change.

Available settings appear.

4 Click a setting.

NOTE: For the text-field options such as Group Name and Notes, you must click and open the 
print option bars to access them. 
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Defining and printing custom page sizes
With custom page sizes, you define the dimensions of a printed page. After you define a 
custom page size, you can use it from within an application without redefining it each time 
you print. When you create custom page sizes, specify Width dimensions to correspond with 
the shorter side of your job and specify Height dimensions to correspond with the longer side 
of your job. Set custom page sizes in this way, regardless of the orientation settings in the 
application.

When you define or edit a custom page size, or print your job on a custom page size in the 
Windows 2000/XP/Server 2003 PostScript printer driver, use the following procedures.

NOTE: Windows 2000/XP/Server 2003 have a similar interface when setting options and 
printing. The following procedures use Windows 2000 illustrations with Windows XP/
Server 2003 differences noted.

TO DEFINE A CUSTOM PAGE SIZE WITH THE WINDOWS 2000/XP/SERVER 2003 POSTSCRIPT PRINTER DRIVER

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Right-click the Fiery EXP4110 PS icon and choose Printing Preferences.

3 Click the Paper/Quality tab.

Height

Width

Width

Height

Portrait Landscape
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4 Click Advanced.

5 Choose PostScript Custom Page Size from the Paper Size menu.

The PostScript Custom Page Size Definition dialog box appears.

6 Specify options to define the custom page size. 

Custom Page Size Dimensions: Enter the width and height of the print job.

Unit: Select a unit of measurement for the print job.

Paper Feed Direction: Choose the paper feed direction of the print job.

Paper Type: Only the Cut Sheet option is available.

Offsets Relative to Paper Feed Direction: Enter the offsets (margins) of the print job relative to 
the paper feed direction.
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7 Click OK to close the PostScript Custom Page Size Definition dialog box.

8 Click OK to close the Advanced Options dialog box.

9 Click OK to close the Printing Preferences dialog box.

You can now specify the custom page size from an application.

NOTE: Access the Paper/Quality tab only for defining or editing custom page sizes. Set up the 
rest of the print options in the Fiery Printing tab.

TO EDIT A CUSTOM PAGE SIZE WITH THE WINDOWS 2000/XP/SERVER 2003 POSTSCRIPT PRINTER DRIVER

1 Windows 2000: Click Start, choose Settings, and then choose Printers. 
Windows XP: Click Start and choose Printers and Faxes.
Windows Server 2003: Click Start, choose Control Panel, and then choose Printers and Faxes.

2 Right-click the Fiery EXP4110 icon and choose Printing Preferences.

3 Click the Paper/Quality tab.

4 Click Advanced.

5 Choose PostScript Custom Page Size from the Paper Size menu.

The PostScript Custom Page Size Definition dialog box appears. If it does not appear, click 
Edit Custom Page Size.

6 Edit the settings, as described on page 52, and click OK.

TO PRINT A CUSTOM PAGE SIZE WITH THE WINDOWS 2000/XP/SERVER 2003 POSTSCRIPT PRINTER DRIVER

1 Choose Print from your application.

2 Select the Fiery EXP4110 as the printer and click Properties.

3 Click the Fiery Printing tab and then click the Paper Source print option bar.

4 Select PostScript Custom Page Size from the Page Size menu.

5 Click the Layout print option bar and select a setting from Orientation, according to the way 
the custom size paper is loaded.

6 Click OK and then click OK again to print the job.

Working with custom page sizes for Windows PCL printer driver

When you define or edit a custom page size, or print your job on a custom page size in the 
PCL printer driver, use the following procedures.
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TO DEFINE A CUSTOM PAGE SIZE WITH ALL WINDOWS PCL PRINTER DRIVERS

1 Click Start.

2 Windows 2000: Choose Settings and then Printers.
Windows XP: Choose Printers and Faxes.
Windows Server 2003: Choose Settings and then Printers and Faxes.

3 Right click the Fiery EXP4110 PCL icon and choose Printing Preferences.

4 Click the Fiery Printing tab and click the Paper Source print option bar.

5 Select Custom from the Page Size print option and click Custom.

6 Specify options to define the custom page size.

Width: Enter the width of the print job.

Length: Enter the length of the print job.

Units: Select a unit of measurement for the print job.

7 Click OK to close the Enter Paper Size window.

8 Click OK to close the Fiery EXP4110 printer driver.
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TO EDIT A CUSTOM PAGE SIZE WITH ALL WINDOWS PCL PRINTER DRIVERS.

1 Click Start.

2 Windows 2000: Choose Settings and then Printers.
Windows XP: Choose Printers and Faxes.
Windows Server 2003: Choose Settings and then Printers and Faxes.

3 Right-click the Fiery EXP4110 PCL icon and choose Printing Preferences.

4 Click the Fiery Printing tab and click the Paper Source print option bar.

5 Select Custom from the Page Size menu and click Custom.

6 Enter the new options to define the custom page size. 

Width: Enter the width of the print job.

Length: Enter the length of the print job.

Units: Select a unit of measurement for the print job.

7 Click OK to close the Enter Paper Size window.

8 Click OK to close the Fiery EXP4110 printer driver.

TO PRINT A CUSTOM PAGE SIZE WITH ALL WINDOWS PCL DRIVERS

1 Choose Print from your application.

2 Select the Fiery EXP4110 PCL icon as the printer and click Properties.

3 Click the Fiery Printing tab, and then click the Paper Source print option bar.

4 From the Paper Source menu, choose the paper tray that contains the custom-size paper for 
the job.

The Paper Source selection is valid for the current job only.

5 Select Custom from the Page Size menu.

6 Click OK and then click OK again to print the job.
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Saving files to print at a remote location
If you do not have a Fiery EXP4110 onsite and are preparing files to take to a service bureau 
or other location, print the final files to the File port (as opposed to one of the local ports). 
You can also print to the File port to create a file to download using Downloader. For 
instructions about printing to the File port, see the documentation that accompanies 
Windows.
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Owner Information 46
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deleting 35
download using WebTools 12
installing from User Software 

(Drivers) CD 14
installing using Point and Print 10
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Windows 2000/XP/Server 2003 16
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Printer Delete Utility 35
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printing

from an application 46
to File port 56
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TCP/IP connection

Windows 2000/XP/Server 2003 20
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Two-Way Communication 30
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